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OVERVIEW: STYLE GUIDE

SCOPE USE CASES

Although this style guide is designed to cover most use cases for written This Style Guide serves multiple purposes:

documentation at PERS, it is not comprehensive of every situation you could

SNECUITEST. 1. Firstly, the design elements can be used as they are. All design elements

discussed in this style guide should be present in the template for your use.
If you are just getting started in InDesign, using the pre-built style elements is

recommended.

2. Secondly, the Appendix in this style guide can serve as inspiration for you to
create your own customized style elements. You will find links throughout the
style guide which will take you to the Appendix where you can get a “look under
the hood” of a design element.

Using this style guide is not intended as a substitute for taking dedicated training on I I
using InDesign. You are encouraged to seek professional development on InDesign ‘

to bolster your skillset and allow you to handle fringe use cases not covered in this
style guide.



TEMPLATE



TEMPLATE

OVERVIEW DATE IN FOOTER

Before publishing a new version of documentation, you will need to edit the parent
page to reflect the day it was last edited.

At the bottom right corner of the screen, open the
page drop-down menu and select A-Parent.

The Documentation Template is designed to be flexible and meet a variety of use
cases: a 50+ page technical manual involving multiple user types and a 6-page job
aid on how you can source and upload a Workday Profile photo.

Here is a quick glance of what is provided in the template:

« Cover Page for Lengthy Documentation

Table of Contents for Lengthy Documentation

Page with Header section for Short Documentation

Standard page for the body of the document (as seen above) ‘ ‘

Paragraph Styles Type in the date you are creating or revising the job aid in

Shapes both pages of the spread. Move the text frame along the
x-axis if needed


file:\\Ppn018\personel\4%20Training\Training%20Development\Job%20Aids\Templates\PERS_Documentation_Template_V1.indd

TEMPLATE

ADD PAGE LEARNING SUPPORT LINK

1. Select the page next to which you wish to insert a new page

All Agency Training job aids should end with instructing learners to fill out a learning
support request in Workday if they have further questions-as is the case in the
documentation template.

2. Press the “+” Button to create a new page.



TEMPLATE

SHORT DOCUMENTATION LENGTHY DOCUMENTATION

For documentation over 10 pages in length and/or involving multiple user types, it
is recommended you use pages “Long-i” and “Long-ii”, instead of page “Short-1”, in
the template.

For documentation under 10 pages in length and/or involving a single user type, it
is recommended that you use page “Short-1” instead of “Long-i” and “Long-ii”. Of
course, neither the page length or number of user types are hard and fast rules. Use

your own judgement on which template to use. , o , ,
Pages “Long-i” and “Long-ii”, intended for longer documentation like procedural

manuals, contain a cover page listing the documentation’s objectives, and most

Page “Short-1”, intended for short documentation like job aids, features a title, the : o , )
Importantly a Table of Contents containing clickable hyperlinks.

documentation’s objectives, and a placeholder for an associated graphic.

Skip ahead to the Lengthy Documentation Section to proceed with this option.

Skip ahead to the Short Documentation Section to proceed with this option.

If you are unsure of how many pages or how many user types your
documentation will have, you can always return to this procedure after you have
spent time building out the body of your documentation.




SHORT DOCUMENTATION



SHORT DOCUMENTATION

OVERVIEW DELETING UNEEDED PAGES

Now that you have determined you don’t need the Table of Contents or Cover
Page, delete pages i-ii and reset the document’s page numbering:

1. From the Pages Panel, select both page i and ii at the same time by using the
Shift button

— 1
Page “Short-17, featuring a header with a graphic placeholder, title, and objectives is
designed to be used for job aids fewer than 10 pages and/or involving a single user
In order to explain “user type”, we will use an example from the \Work out of 2. Select the trash icon within the Pages Panel

Class DocuSign Job Aid. WOC Managers, Appointing Authorities, rank and file
Employees, and Human Resources all play a role in the process of completing a
Work out of Class form using DocuSign. Since each user type has their own set of
instructions in the user manual, the Table of Contents would be more appropriate
because they can skip to the set of instructions that are relevant to them.



https://ecmicn.p.pers.state.or.us/navigator/bookmark.jsp?desktop=training&repositoryId=Agency&repositoryType=p8&docid=SB1049Training%2C%7B3CCDB3C2-DC3A-4800-876D-903DC30F288D%7D%2C%7BFCB11182-414A-C9E6-851E-888E0FC00000%7D&mimeType=application%2Fpdf&template_name=SB1049Training&version=released&vsId=%7B565247D8-F4CB-CC8F-856B-888E0FC00000%7D
https://ecmicn.p.pers.state.or.us/navigator/bookmark.jsp?desktop=training&repositoryId=Agency&repositoryType=p8&docid=SB1049Training%2C%7B3CCDB3C2-DC3A-4800-876D-903DC30F288D%7D%2C%7BFCB11182-414A-C9E6-851E-888E0FC00000%7D&mimeType=application%2Fpdf&template_name=SB1049Training&version=released&vsId=%7B565247D8-F4CB-CC8F-856B-888E0FC00000%7D

SHORT DOCUMENTATION

GRAPHIC

3. Right Click on the page “Body-1" and select “Numbering and Section
Options” from the dialog box

— 1
— 2
Place a sourced vector or image within the rectangle frame of page “Short-1".
4. Uncheck the box “Start Section”. Press “OK?”. You may wish to use Adobe Stock, Creative Commons photos, Vecteezy, flaticon,
etc. to source a vector or high-resolution png file.



https://www.lifewire.com/indesign-cs-frame-and-shape-tools-1078494?utm_source=emailshare&utm_medium=social&utm_campaign=shareurlbuttons#mntl-sc-block_1-0-17

SHORT DOCUMENTATION

OBJECTIVES

Articulate the job aid’s objective(s) by editing the placeholder objectives in the
header of this template.

Generally, the terms “understand” or “know” should not be used
when writing objectives. For more information on writing measurable
objectives, check out this article from the University of Arkansas.

TITLE

There should only be one Title per document, which describes the documentation’s

topic in broad strokes; usually only a few words.

T

For one objective, type out a sentence.

Delete the text frame containing bullet For multiple objectives,
points. use bullet points. These

bullet points are styled
using the paragraph
style: “Objectives-
Header”

Generally, you will simply edit the title present in the Header of this template.
Otherwise, you can select the “Title” style from the Paragraph Panel.

10


https://tips.uark.edu/using-blooms-taxonomy/

LENGTHY DOCUMENTATION

11



LENGTHY DOCUMENTATION

OVERVIEW DELETING UNEEDED PAGE

Now that you have determined you will be using the long documentation format,
delete the page “Short-1":

1. From the Pages Panel, select page “Short-1"

Pages “Long-i” and “Long-ii”, featuring a Cover Page and Table of Contents, are 5
typically intended for documentation which is over 10 pages long and/or involves '
multiple user types.

2. Select the trash icon within the Pages Panel

When the documentation is lengthy or involves several different user types, the
navigability provided by the Table of Contents is crucial to saving the user time and

frustration.

Also, the Cover Page gives space for more objectives than the “Short-1” page.

12



LENGTHY DOCUMENTATION: TABLE OF CONTENTS

TOC: PARAGRAPH STYLES HEADERS

Paragraph Styles, besides allowing us to quickly and easily maintain design A “Header” not only improves the skimmability of documentation, but is also the
consistency across a piece of documentation, are the building blocks for a Table of first building block for the Table of Contents.

Contents in InDesign. It is important to label your text frames correctly in the body

of your document so they show up (correctly) in the Table of Contents. Below is an example of how labeling the text frame “Overview of Work out of

Class” as a “Header” paragraph style in the body of the InDesign Document, in turn
displays that header in the Table of Contents.

N\

N\

The following paragraph styles are used in the Table of Contents; click to be
redirected to information on a particular paragraph style:

« Header
« Subheader
« Sub Subheader

« Subheader_ Finale

13



LENGTHY DOCUMENTATION: TABLE OF CONTENTS

SUBHEADERS

Above is an example of how labeling the text frame “Canceling” as a “Subheader” in
the body of the Teams Job Aid in turn displays that text in the Table of Contents.

INDENTED SUBHEADERS

Although “Sub_Subheader” has the same style as the other subheaders within
the body of the InDesign document, it is programmed in the Table of Contents to

be indented- as shown above. This allows you to chunk relevant content together
further.

One example of using the “Sub_Subheader” paragraph style is from
the Outlook job aid, where Security Levels Explained is indented under
Create Email Signatures because one may wish to add security levels to
their email signatures when communicating externally.

14


https://ecmicn.p.pers.state.or.us/navigator/bookmark.jsp?desktop=training&repositoryId=Agency&repositoryType=p8&docid=SB1049Training%2C%7B3CCDB3C2-DC3A-4800-876D-903DC30F288D%7D%2C%7B5C8ADBAD-29CD-CDAB-86AC-7E2CA7700000%7D&mimeType=application%2Fpdf&template_name=SB1049Training&version=released&vsId=%7B6454E1BA-3D79-CD57-8511-7E2CA7700000%7D
https://ecmicn.p.pers.state.or.us/navigator/bookmark.jsp?desktop=training&repositoryId=Agency&repositoryType=p8&docid=SB1049Training%2C%7B3CCDB3C2-DC3A-4800-876D-903DC30F288D%7D%2C%7B4616A869-C871-CF91-874E-8714EDA00000%7D&mimeType=application%2Fpdf&template_name=SB1049Training&version=released&vsId=%7BEB050EAB-D7CA-C1F0-85B3-8714EDA00000%7D

LENGTHY DOCUMENTATION: TABLE OF CONTENTS

FURTHER QUESTIONS TOC: STYLING
I I
‘ The styling of the Table of Contents should happen automatically. However, if you
need to edit the following elements in the TOC, please edit the corresponding entry
(paragraph) style-as can be observed within the Table of Contents Dialog Box:

« Title (“Contents”): TOC Title

“Further Questions”, where a link to a job aid is provided on how to request learning « Headers: TOC Level 1
support through Workday, is labeled with the Paragraph Style “Subheader_Finale” _
so that it is styled differently from the other subheaders in the Table of Contents. Subheaders: TOC Level 2
« Further Question Subheader: TOC Level 3

« |ndented Subheaders: TOC Level 4

To learn more about building a Table of Contents using Paragraph styles,
check out this video.

15


https://youtu.be/m4y2tm6LH_c

LENGTHY DOCUMENTATION: TABLE OF CONTENTS

TOC: UPDATING

As you add or delete pages/headers/subheaders to your document, you want the 2. Under the “Layout” Menu tab, select “Update Table of Contents”
Table of Contents to reflect those changes. The process of updating the Table of
Contents happens manually, as is depicted in the following scenario where a new
subheader is added:

1. Select the text frame containing the Table of Contents.

16



LENGTHY DOCUMENTATION TEMPLATE: COVER PAGE

TITLE

Describe the purpose of the documentation in
broad strokes by editing the Title placeholder in this
template.

The Title on the Cover page should use the
Paragraph Style “TitleonCoverPage”.

GRAPHIC

Obtain a vector/high-resolution image that is

associated with the content of the documentation.

You may wish to use Adobe Stock, Creative
Commons photos, Vecteezy, flaticon, etc. to
source this file.

Place the sourced vector or image within the

rectangle frame of page i.

OBJECTIVES

Write out the objectives on the Cover Page of the

Template.

Generally, the terms “understand” or “know”
should not be used when writing objectives.
For more information on writing measurable
objectives, check out this article from the
University of Arkansas.

The Objectives on the Cover page should use the

Paragraph Style “ObjectivesforCover”.

17


https://www.lifewire.com/indesign-cs-frame-and-shape-tools-1078494?utm_source=emailshare&utm_medium=social&utm_campaign=shareurlbuttons#mntl-sc-block_1-0-17
https://www.lifewire.com/indesign-cs-frame-and-shape-tools-1078494?utm_source=emailshare&utm_medium=social&utm_campaign=shareurlbuttons#mntl-sc-block_1-0-17
https://tips.uark.edu/using-blooms-taxonomy/
https://tips.uark.edu/using-blooms-taxonomy/

PARAGRAPH STYLES

18



PARAGRAPH STYLES

WHAT IS A PARAGRAPH STYLE? CREATE YOUR OWN

The Paragraph Styles found within each template are not intended to be
comprehensive. You are encourage to create your own as the need arises.

Paragraph Styles help to maintain consistency throughout the documentation.

They allow us to apply specific character and paragraph styles to a text frame with This is a paragraph style that was
a single click. To learn more about paragraph styles, check out this article from g | created specifically to fit bullet
Adobe. points in these two narrow columns.

Besides maintaining design consistency, Paragraph Styles are crucial to the
functioning of the Table of Contents.

19


https://helpx.adobe.com/indesign/using/paragraph-character-styles.html
https://helpx.adobe.com/indesign/using/paragraph-character-styles.html

PARAGRAPH STYLES

NUMBERED STEPS

Set Up Automatic Replies

1. From your Microsoft Outlook inbox, click on the File menu option from the ribbon bar in
the top left corner of your inbox.

£ search

Home Send/Receive  View Help  Acrobat Try the new Outlook

New Email v [ﬂ v = D¢v ‘-) /A/ — @ Share to Teams e Unread/ Read EEV PJ < Flplv Search People @

.

I 2. Next, click the Automatic Replies button. I

There are eight numbered list styles within

the documentation template, which allow you

to create eight different numbered directions
across multiple text frames and pages. These
paragraph styles have the following notation:
“NumberedList-X". Select the paragraph style
“NumberedList-1” when you are creating the first
level (1, 2, 3, 4) of the first numbered list within
your InDesign file, and so on.

Numbering directions across pages and/or
frames requires the use of defined lists within
InDesign. If you need to create more numbered
lists or adjust current ones, watch this video.

OPTIONS

OPTIONS WITHIN OPTIONS

10. Select whether the WOC position will be a new assignment or an extension of an existing
assignment. Depending on your selection, you may have additional options.

Select one radio button FINISH LATER OTHER ACTIONS v

@a & 86 0 &

Option A ﬁDNcw assignment

*Attach job duties if they are new or a portion of an established position OR
*Use duties from position number (if all duties of this position will be assigned). l

Start date: End date:

WOC assignments may end at any time or when the purpose no longer exists.

Option B ﬁ OExtension: Attach job duties only if they have changed. New end date:

A. If you select that the WOC position will be a New assignment, select the intended start
and end dates for the employee you are planning to have Work out of Class using the
calendar dialog boxes. You can request to have Work out of Class extended later if
needed.

Sometimes there may be multiple ways of
completing a step. In these instances, first describe
what needs to be accomplished in the first level.
Then, use the paragraph style “NumberedList-X-
SecondlLevel” to mark each option for completing

the step in the first level.

If you insert a new numbered list item before
an existing list item of the same paragraph
style on the same page, the automatic
numbering likely will not work correctly. For a
solution, read this discussion.

Please note that all objects should be aligned
to the step with which they correspond. For
instance, the image above is aligned to step A,
not to step 1.

i. If thereis a match between the position description of a position the employee will
be working out of class in enter that position number here (available via Workday’s
Org Chart feature- as shown in Step 4).

An example of when you would use this option is if Cindie Lang, Human
Resources Analyst 2, will be working out of class as a Human Resources
Analyst 3 for three months to fill in for Tia Fairchild ‘s absence while Tia is
out on Leave.

& ©

Cindie Lang Tia Fairchild
Human Resource Analys... Sr. Human Resources G...
Human Resource Analys... Human Resource Analys...

000000028715 00000004495

- 00000

i. Sometimes Working out of Class will involve new responsibilities for which there is no
one currently within the agency with a matching position description (e.g. the WOC
is not to fill in for someone else while they are temporarily on leave). If this is the
case, attach the position description, which contains the job duties, here. All position
descriptions in the agency can be found within the Position Description Folder in
K Drive: k\Human Resources\POSITION DESCRIPTION\PD Updates\Position by

Division

In some very rare instances, there will be options
within options for a particular step-as depicted

in the WOC DocuSign Job Aid (above). In these
instances, use the paragraph style “NumberedList-
X-ThirdLevel” to mark the third level.

20


https://youtu.be/y4dfFRwDAJw
https://community.adobe.com/t5/indesign-discussions/same-page-figure-numbering-not-in-order/td-p/10317310

PARAGRAPH STYLES

DIRECTIONS (NON-SEQUENTIAL) BULLET POINTS COMMENTARY BOXES

In order to use bullet points within the body of the
InDesign document:

1. Select the text box with which you intend to set
the paragraph style

Commentary Boxes add additional context or

an explanation to a direction. In order to use a
commentary box, copy and paste the example
commentary box from the template.

2. Select “BulletPoints_Body” from the Paragraph

Sometimes there is not a linear set of steps, but Styles Panel
a general set of principles to be applied by the
learner. In this case, one option is to use the
paragraph style “TextBody” from the Paragraph
Styles panel.

This paragraph style is not intended for the
objectives found on the cover page, “Long-i” or
the objectives found on the Header Section of
page “Short-1".

If you would like to view the settings through
which the commentary box was constructed,
skip to its section in the Appendix.

Did you know? You can create a case two separate ways.: €—>
A. Using keywords in the Global Search Bar
B. Viathe Help App in Workday

The Box should only extend the width of the text;
unlike in the above example.

21


https://wd5.myworkday.com/oregon/wdhelp/helpcenter

PARAGRAPH STYLES

HEADERS

Outlook Email

Create Email Signatures

Before creating an email signature check with your manager to see if there are any
requirements that need to be included with your email signature.

1. From your Microsoft Outlook inbox, click on the File menu option from the ribbon bar in
the top left corner of your inbox.

}3 Search

Home  Send/Receive View Help  Acrobat Try the new Outlook

New Email ~ ]E[ - B E‘J'"l“ S €& — | i SharetoTeams = (&) Unread/Read 5O~ FU & %" Search People @

o

SUBHEADERS

Outlook Email

Create Email Signatures

Before creating an email signhature check with your manager to see if there are any
requirements that need to be included with your email signature.

1. From your Microsoft Outlook inbox, click on the File menu option from the ribbon bar in
the top left corner of your inbox.

/O Search

Home  Send/Receive View Help  Acrobat Try the new Outlook

New Email ~ E[ - B E‘Jf"lv S € — | o SharetoTeams = (&) Unread/Read 55 v FU 4 F'E," Search People @

o

Headers can be used to improve the navigation and skimmability of documenation.

Headers are not required for short documentation, as there is no Table of
Contents. To understand the relationship between the “Header” paragraph
style and the Table of Contents, go here. In some scenarios, adding headers
does not improve navigation. An example is the Manager 1:1 Job Aid:

adding header(s) to this three page document doesn’t add any more useful
information than the Title already provides.

In order to create your subheader, type in text into a new text box and then select
“Header” from the Paragraph Styles Panel with the text box selected.

Subheaders should be used for separating out subsections of a job aid, such as
“Create Email Signatures” within the Outlook Job Aid.

In order to create your subheader, type in text into a new text box and then select
“Subheader” from the Paragraph Styles Panel with the text box selected.

22



https://ecmicn.p.pers.state.or.us/navigator/bookmark.jsp?desktop=training&repositoryId=Agency&repositoryType=p8&docid=SB1049Training%2C%7B3CCDB3C2-DC3A-4800-876D-903DC30F288D%7D%2C%7B54123AC2-41AB-C25B-8409-7E0DEDF00000%7D&mimeType=application%2Fpdf&template_name=SB1049Training&version=released&vsId=%7BE9587DE7-D3F6-C6DA-9136-7E0DEDF00000%7D

SCREENSHOTS

23



SCREENSHOTS

CAPTURING SCREENSHOT

Capture a screenshot using your largest monitor for the best resoluton.

|| ]

SCREENSHOT SPECIFICATIONS

Generally, exclude the scroll bar on a browser window. In cases where directions
involve scrolling on a longer page, include it.

Don’t cut off any words, shapes, people, assets, etc. while capturing
your screenshot.

Generally, exclude the cursor when taking a screenshot. Only include the cursor
when it’s necessary in order to demonstrate a certain procedure-such as the above
screenshot where how to display a tooltip is being demonstrated.

24



SCREENSHOTS

SCREENSHOT STYLING ZOOMED IN OVERLAY

Sometimes it will be difficult to adequately zoom in on a key feature of a screenshot
without cutting off words, shapes, etc. In this case, use a zoomed in overlay- as
shown above.

1. Take a second screenshot which is more zoomed in on the key feature. You may
need to adjust your monitor’s scaling settings

Add the following styling options in InDesign to the rectangle frame which contains 2. Position the zoomed in screenshot by the original screenshot
your screenshot:
(o) H .
. Stroke: 1 pt, Black 3. Add 10% drop shadow and an outline of 1.5pt, #000000 to the zoomed in
I screenshot

« Drop Shadow Effect with 10% Opacity

4. Place a rectangle with an outline of 1.5pt, #000000 around the part of the
original screenshot you are magnifying

5. Create a line, with a stroke of 1.5pt, #000000 which connects the two
screenshots

25


https://www.windowscentral.com/how-set-custom-display-scaling-setting-windows-10

SCREENSHOTS

RECTANGLES

We can focus user attention on a particular part of the user interface by using a blue
rectangle shape.

The Blue Rectangle should have the following settings:

« Stroke: 2 Pt, Solid, #0600F5 (“TheJobAidBlue”)

« 90 degree corners; do not use rounded rectangles as shown above

ARROWS

If you would like to draw additional attention to a particular part of a screenshot
beyond the blue rectangle, use a blue arrow.

When using an arrow to draw additional attention to a screenshot, position it 5
pixels (5 arrow > keystrokes) from the stroke of the rectangle.

Arrows can also connect steps in a discrete process, as shown above.

If you would like to view the settings through which the arrow was constructed,

skip to its section in the Appendix.

26



SCREENSHOTS

NUMBERED BOXES

Sometimes, a screenshot will need to depict
multiple steps. In this case, use the numbered

boxes available within either of the two templates.

The Numbered Boxes are made using the
paragraph style “Blue_Numbered_Box”.

LACK OF CONTRAST

The Dark Blue, #0600F5, that is used for arrows,
rectangles, and numbered boxes can in some
occasions not provide enough contrast with the
Image below it. In these instances, apply a 20%
drop shadow to the aforementioned objects

to start off. If you feel there is still not enough
separation, you may increase the percentage
opacity up to 40%.

The text below an object may create a lack
of separation between an object and the

screenshot below it. The drop shadow effect can

also be used to mitigate these circumstances.

A lack of color contrast between a blue region of
a screenshot and one of the blue objects above
it is one reason you would need to add a drop

shadow effect.

27



ALIGNMENT
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ALIGNMENT

USING MARGINS

Objects generally

should not extend
past the rightmost
margin.

Align all objects to the pink 0.5 inch margins- as shown above.

In order to toggle between viewing the margins, guides and frame edges (in
normal mode), and seeing how the document will look when exported (in
oreview mode) hit the “W” key.

PITFALL: OVERSIZED FRAMES

2.| Select “Learning Support” from the drop down options under Case Type.

Create About

Search name ‘

This persan won't get any notifications abouwt this case

Case Type™

Belect the most relevant case type
> =
{

() )
| |
General Human Resources Support \U/

—

Human Resources (Confidential)

‘LearningSuppDrt i h

Payroll Support

- solution

The actual images, not just the frames containing the image, should be aligned with

the margins to the greatest extent possible. Pay attention to this particularly when
there is lots of whitespace within the screenshot; see above where the image fram
Is aligned with the margin but the screenshot is not.

The commands under Object > Fitting may help to keep the size of the frame
and its corresponding contents in sync. In particular, the command “Fit frame
to Content” may be helpful.

e
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https://design.tutsplus.com/tutorials/how-to-preview-in-indesign--cms-38638
https://design.tutsplus.com/tutorials/how-to-preview-in-indesign--cms-38638
https://design.tutsplus.com/tutorials/how-to-preview-in-indesign--cms-38638
https://helpx.adobe.com/indesign/using/frames-objects.html#:~:text=Follow%20these%20steps%20to%20fit%20an%20object%20to,fit%20content%20C.%20Content%20resized%20to%20fit%20frame

ALIGNMENT

PITFALL: NUMBERED LISTS

N\

Numbers in numbered lists, not the indented textual directions, should be aligned to
the margin. The above screenshot is a bad example of this.

EXCEPTION: OPTIONS

There is one exception to the rule of aligning all objects to the pink 0.5 inch margins:

options and options within options when creating sequential directions:

Align objects with their corresponding sequential direction-like how the commentary

box and screenshots are aligned with i. in the screenshot above.

Setting Ruler guides of 0.6875 and 0.875 inches may help in aligning with options

(e.g. A) and options within options (e.g. i), respectively.
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https://helpx.adobe.com/indesign/using/ruler-guides.html

SPACING
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SPACING

MEASURE SPACING

You can check the spacing between two
objects on an artboard using the Gap tool:

1. Select the Gap Tool

2. Hover over the gap you want to measure

1. Open the PERS Intranet Home Page in your browser.

2. Select the “Forms” link from the PERS Intranet Home Page.

3. Read the Height (or Width if you are measuring
horizontal distance) in the Control Panel

BEFORE USING DISTRIBUTE
SPACING

In order to utilize the distribute vertical spacing
feature effectively, you should:

Ctrl = G

« Group objects together with the screenshot so
they remain in their correct position in relation
to the screenshot when you use the distribute
spacing feature

« Ensure the text boxes and image frames are only
as large as is necessary to fit the contents. The
above screenshot is a bad example of this

SPACING ELEMENTS

Spacing between elements should be consistent.

Set the spacing of objects by selecting the objects
you wish to space, setting the spacing amount
(with the “Use Spacing” Checkbox selected), and
using the Distribute Spacing- Distribute Vertical
Space Button (within the Align Panel).
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https://helpx.adobe.com/indesign/using/aligning-distributing-objects.html
https://helpx.adobe.com/indesign/using/aligning-distributing-objects.html
https://helpx.adobe.com/indesign/using/grouping-locking-duplicating-objects.html
https://graphicdesign.stackexchange.com/questions/101537/how-to-measure-distance-in-indesign

SPACING

AROUND HEADERS & SUBHEADERS ELEMENTS OF SAME STEP/SECTION

$ 0.25 inches T 0.1875 inches

Generally, a Header will be the start of each section of documentation; such as
Microsoft Teams and Cisco Softphones within the Teams Job Aid. Spacing between

Headers and the start of a related Subheader or other related section element
should be 0.25 inches.

I 0.25 inches

The space around Headers should be the same as that for Subheaders: 0.25 inches , o ,
Spacing between elements within the same step number or section should be
0.1875 inches (e.g. text box, screenshot).

Spacing in this style guide is included heavily by Gestalt’s Proximity Principle; that
Is like elements should be grouped closer together. This is why the spacing is
closest between elements of the same section or step number.
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https://builtin.com/design-ux/gestalt-proximity-principle-design

SPACING

AROUND COMMENTARY BOXES ELEMENTS OF DIFFERENT STEPS/SECTIONS

I 0.25inches

There is one other exception to the guideline of spacing elements of the same step
or section: commentary boxes. T 0.375 inches

Spacing between elements in one step or section and the start of a new step or
section on the same page should be 0.375 inches.

T 0.25 inches

Spacing between Commentary boxes and other elements within the same step or I 0.375 inches
section should be 0.25 inches.
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APPENDIX

OVERVIEW SCREENSHOT RELATED SHORT DOCUMENTATION
ELEMENTS

Title in Header

Blue Numbered Boxes |1

« Metropolis SemiBold
« Font: Metropolis Medium, 16Pt, #0600F5

- 16Pt
« Paragraph Border: 1.5 Pt, Solid, #0600F5 . #000000
« Paragraph Shading: #ffffff
- Baseline Shift: -0.5 Pt Objectives in Header

« Font: Metropolis Regular, 13Pt, #000000

You may need to resize the text frame after the

paragraph style has been applied.
As stated in the Overview Section, this Appendix « List Type: Bullets

gives you the ability to “look under the hood”

« Hyphenation: No

. Arrows ) . : i
of the various stylistic elements present in Left Indent: 0.3125 inches
the documentation template; from arrows to « Width: 0.2125 inch « First Line Indent: -0.3125 inches
paragraph styles. You may find this information to Ueight: . .
: « Height: 0.8333 inch . -
be useful when creating a new paragraph style or 9 | Space Before: 0.03 inches
other stylistic element. « Fill: #0600F5

Load paragraph styles from the template
document into your current one rather than
trying to copy the settings found here. Likewise,
use the arrows and commentary boxes found
within the template rather than trying to copy
the settings found here to create an identical
stylistic element.
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https://youtu.be/TRNgq--5xMs

APPENDIX

LENGTHY DOCUMENTATION

“Title on Cover Page”

« Metropolis SemiBold
« 20Pt
« #000000

« Alignment: Center

Objectives on Cover Page

« Font: Metropolis Regular, 13Pt, #000000
« Hyphenation: No

« List Type: Bullets

« Space Between Paragraphs Using Same Style:
0.1875 inches

« Space Before: 0.125 inches
« LeftIndent: 0.4375 inches
« First Line Indent: -0.4375 inches

TABLE OF CONTENTS STYLING

TOC Title

« Font: Metropolis SemiBold, 24Pt, #000000
« Space Before: 0.125 Inches
« Space After: 0.0625 Inches

TOC Level 1 (Headers)

« Font: Metropolis Medium, 15Pt, #000000
« Space Before: 0.1875 Inches
« Space After: 0.0625 Inches

« Space Between Paragraphs using Same Style:

0.25 Inches

TOC Level 2 (Subheaders)

« Font: Metropolis Regular. 13Pt, #000000
« LeftIndent: 0.5 inches

« Space Before: 0.125 Inches

« Space After: 0.0625 Inches

« Space Between Paragraphs using Same Style:

0.1875 Inches

TOC Level 3 (“Further Questions” Subheader)

Font: Metropolis Regular. 13Pt, #000000
Left Indent: O inches

Space Before: 0.1875 Inches

Space After: 0.1875 Inches

Space Between Paragraphs using Same Style:
0.1875 Inches

TOC Level 4 (Indented Subheaders)

Font: Metropolis Regular. 13Pt, #000000
Left Indent: 0.875 inches

Space Before: 0.125 Inches

Space After: 0.0625 Inches

Space Between Paragraphs using Same Style:
0.1875 Inches
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APPENDIX

HEADERS & SUBHEADERS SEQUENTIAL DIRECTIONS
Headers Numbered Steps Options within Options
« Metropolis SemiBold « Character: Metropolis Regular, 12Pt, #555555 « Character: Metropolis Regular, 12Pt, #555555
. 16pt « Hyphenation: No « Hyphenation: No
« Character Fill: #000000 « List Type: Numbers « List Type: Numbers
« Format:1, 2, 3, 4... « Format:i, ii, iii, iv...
Subheaders « Level:1 « Level: 3
* Metropolis SemiBold « Mode: Continue from Previous Number « Mode: Continue from Previous Number
+ 14Pt « Left Indent: 0.3125 in « Restart Numbers at this Level: After Any
« Character Fill: #555555 Previous

« First Line Indent; -0.3125 in
« Left Indent: 0.6875 in

Options « First Line Indent: -0.3125 in

« Character: Metropolis Regular, 12Pt, #555555
« Hyphenation: No

« List Type: Numbers

« Format: A, B, C, D...

« Level: 2

« Mode: Continue from Previous Number

« Restart Numbers at this Level: After Any
Previous

« LeftIndent: 0.5in
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APPENDIX

MISCELLANEOUS TEXTUAL
ELEMENTS

TextBody

Metropolis Regular
12Pt

Fill: #555555
Hyphenation: No

BulletPoints_Body

Font: Metropolis Regular, 12 pt, #555555
List Type: Bullets

Left Indent: 0.25 inches

First Line Indent: -0.25 inches

Space Before: 0.0625 inches

Commentary Boxes

Font: Metropolis Medium, 12pt, #1111
Hyphenation: Off

Text Frame Options:

e Fill: #e9¢c99e
« Stroke: 1 pt, black
« |nset Spacing: 0.0625 inches

« Autosize: height

COLOR SWATCHES

Named color swatch can be selected within the
swatches panel.

“TheJobAidBlue”

This named color swatch stands in for the hex
code #0600F5.

Black

This named color swatch stands in for the hex
code #000000
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https://www.youtube.com/watch?v=n8qFhkE6GAQ
https://helpx.adobe.com/indesign/using/swatches.html

TEMPLATE 3 COLUMN

HEADER 1
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TEMPLATE 2 COLUMN

HEADER 1
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